The lllustrator Template File Page - 1

o o= R All of the Output Center Laser Cutters
: o S use this lllustrator Template for file
’ setup.
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Other file types, such as DXF and
DWG will not be accepted, but can
be imported into this document.
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Preferences

This template has two main functions:

(] Use Preview Bounds

(] Scale Corners

e All objects should be inside the boundaries of the box above. Use the magenta lines
for placement when cutting basswood. Use the violet lines when cutting acrylic.

e All BLACK objects or lines will be SKIPPED. 1. The tOp of the template enNsures

® Assign global RED for vector lines that will be CUT. The lineweight must be .01 pts.

® Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line- eferences th at th e d eS | g ﬂ |S th e CO rreCt S i Ze fO r

(] Scale Strokes & Effects

Quick Actions

Document Setup

weight must be .01 pts.

¢ Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be th e |aser CUtterS .
thicker than .75 pts to be raster engraved. USE SPARINGLY! Raster engraving takes

much longer than vector engraving. Th iS iS O Utl i ﬂ ed i n

® Assign global BLUE for vector lines that will be SCORED. The lineweight must be
.01 pts. This setting cannot be used on acrylic or basswood.

i 2. The bottom of the template acts
as a quick reference guide for
formatting the design for the laser
cutters.




Understanding Material Dimensions Page - 2

e e —— | The top half of the template is where
’ the design will be placed.
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The outlined areas represent the
different types of materials that can
be cut and their dimensions.

The design that is placed in this
file must fit within these specified
areas, depending on the desired
material.
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”f§ For example:

:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::_:E'_'______J The chosen material for a design Is
Basswood.

The maximum bed SIZE IS 32In X 18 1N Therefore, the design must fit within

the 30” x 6” space on the template.




Understanding Color Setup Page - 3

The bottom half of the template is a guide
for formatting the design by assigning

Color Swatches: colors to lines and objects.
Global Pure Red

Color Picker

Orange
B Global Yellow

Cancel The laser cutter uses these preset Color
Color Models Swatches to determine which lines need
to be cut, scored, or engraved.

Global Pure Green
Global Pure Blue
R=0 G=8 B=0
R=236 G=0 B=140
Violet

GLOBAL PURE RED = CUT

B 00000800808

GLOBAL PURE BLUE = SCORED

. S— MAGENTA, BLACK, ORANGE, and
If the Color Swatches are edited, the file will not VIOLET will not be cut.

cut. DO NOT EDIT THESE COLOR SWATCHES




Placing the Design into the Template Page - 4

@) #H = Adobe lllustrator 2021 o Q Q- @ @S = Adobe lllustrator 2021 Q ¢ Q-

X Untitled-1* @ 17.15 % (RGB/Preview) % TestFile [Converted].Al* @ 63.44 % (RGB/Preview) % Untitled-1* @ 17.15 % (RGB/Preview) X TestFile [Converted].Al* @ 63.44 % (RGB/Preview)
Properties Layers Libraries Properties Layers Libraries
8 4 8] 4 8 12 16
Path N L I i A e - e A e e— S s A A R ... © ~ . Your objects ...
© . <Path>
Transform
©® H <Path>
X: 927.5151 W: 594.4223 ® . <Path>
Y: 534.5px  H: : © B <patn>
4a: 0° v q Y E Lo T % Information ...
' ) |
o 0 o 3 a :
% S '
Appearance = S |
C g :
Fill 2 %9
..... W r & ek,
[u] [u] i H,&‘-
................ : R
S
LR

* All objects should be inside the boundaries of the box above. Use the magenta lines

Eh = & = for placement when cutting basswood. Use the violet lines when cutting acrylic.

* All BLACK objects or lines will be SRIPPED.

¢ Assign global RED for vector lines that will be CUT. The lineweight must be .01 pts.
® Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line-
weight must be .01 pts.

® Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be
thicker than .75 pts to be raster engraved. USE SPARINGLY' Raster engraving takes
much longer than vector engraving.

* Assign global BLUE for vector lines that will be SCORED. The lineweight must be

.01 pts. This setting cannot be used on acrylic or basswood.

Pathfinder

L L T

Quick Actions

Offset Path

Recolor

Selection » 2 Layers [T Q & b= T

~ Selection »

Mac: (command+C) and (command+V) The design will be placed in the YOUR OBJECTS HERE!
the design into the template. layer.

Windows: (Ctrl+C) and (Ctrl+V) the This is to help organize your file and quickly edit pieces of
design into the template. the design.



Setup for Cutting a Line Page - 5

TRICE RISICIES Edit a line or object by opening the
X U8ntitled-1*@ 17.13 % (RGB/Preview) x TestFile [Converted].Al* @ 54.21 % (RGB/Preview) 3 3 ; VR T PrOpertieS Tab.

——————————————————————————————————————————————————————————————————————————————————— Path

Transform

LN Sct the color of the line (Stroke) or

Y: 9.0182in H: 2.9263 in

T object (Fill) to Global Pure RED
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& —=— s Set the line weight of the line or
k) \ < — =§‘ = T '
> AN 2 5 s T object to .01 pts.

VASE I W4 4 4 4 4

* All objects should be inside the boundaries of the box above. Use the magenta lin — Th IS ||ne O I ObJeCt Wi “ be C UT by the

for placement when cutting basswood. Use the violet lines when cutting acrylic. | a S e r C u.t.t e r
¢ All BLACK objects or lines will be SKIPPED. "

® Assign global RED for vector lines that will be CUT. The lineweight must be .01 pt
* Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line. EESSSNCINS B o Se— Recolor
weight must be .01 pts.

| | | | This will apprear very thin, but is
® Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be
thicker than .75 pts to be raster engraved. USE SPARINGLY! Raster engraving takes Arrange N ece S S ary fo r C U't'tl N g .

much longer than vector engraving. Start Clobal Edit
*® Assign global BLUE for vector lines that will be SCORED. The lineweight must be
.01 pts. This setting cannot be used on acrylic or basswood.

| ' Connect lines when possible to
streamline the cutting process.
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Be aware of double lines in the file, as double lines can
decrease cut quality and potentially burn the material.




Setup for Vector Engraving a Line Page - 6

TRICE RISICIES Edit a line or object by opening the
X U8ntitled-1*@ 17.13 % (RGB/Preview) x TestFile [Converted].Al* @ 54.21 % (RGB/Preview) 3 3 ; VR T PrOpertieS Tab.

——————————————————————————————————————————————————————————————————————————————————— Path

Transform

el ol Sct the color of the line (Stroke) or

Y: 12.6994i H: 3.5586in

T object (Fill) to

/
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Set the line weight of the line or
o object to .01 pts.
- VASE VAWUV% 4 4 4 4
e A jecs should o nside the bodaries of th bax abov, Use e agenia I This line or object will be VECTOR
| ENGRAVED by the laser cutter.
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for placement when cutting basswood. Use the violet lines when cutting acrylic.

¢ All BLACK objects or lines will be SKIPPED.

® Assign global RED for vector lines that will be CUT. The lineweight must be .01 pt
* Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line. EESSSNCINS - i SS—— Recolor
weight must be .01 pts.

_ | | | Vector Engraving marks the surface
® Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be . i B}
thic}:(]erl than .7h5 pts to be raster engraved. USE SPARINGLY'! Raster engraving takes Arrange Of th e m aterl al Wlth O Ut C Uttl n g
much longer than vector engraving. Start Global Edit .
through the material.

*® Assign global BLUE for vector lines that will be SCORED. The lineweight must be
.01 pts. This setting cannot be used on acrylic or basswood.
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3
2
17.13% ~ Selection | 4

This type of engraving Is quicker and can be used to create
tiny, delicate markings on the surface of the material.




Setup for Raster Engraving a Line Page - 7

TRICE RISICIES Edit a line or object by opening the
X U8ntitled-1*@ 17.13 % (RGB/Preview) x TestFile [Converted].Al* @ 54.21 % (RGB/Preview) 3 3 ; VR T PrOpertieS Tab.

N Path

>‘ D at

"‘ Transform ]

” Rl Sct the color of the line (Stroke) or

s .z object (Fill) to Global Pure GREEN

T, g‘:g

& a’g o ME . . |

..... ‘ S Set the line weight of the line or
DRE A = . object to .75 pts.

L~ VAEE WY 4 4 4 4
[ —— — This line or object will be RASTER
| ENGRAVED by the laser cutter.

for placement when cutting basswood. Use the violet lines when cutting acrylic.

¢ All BLACK objects or lines will be SKIPPED.

® Assign global RED for vector lines that will be CUT. The lineweight must be .01 pt
* Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line, EFESSSNCINS - i
weight must be .01 pts.

. | | | Rl Raster Engraving marks the surface
® Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be . . i
thic}:(]erl than .7h5 pts to be raster engraved. USE SPARINGLY'! Raster engraving takes ALt Of th e m ateﬂ al Wlth O Ut C Uttl n g
much longer than vector engraving. Start Global Edit .
® Assign global BLUE for vector lines that will be SCORED. The lineweight must be th rO U g h th e m ate rl al y aﬂ d Can be
used to engrave areas rather than

.01 pts. This setting cannot be used on acrylic or basswood.
17.13%  ~ Selection » . .
just lines.

Raster Engraving should be used sparingly, as it takes
significantly longer than cutting or vector engraving.




Difference Between Raster VS. Vector Page - 8

The difference between Raster
Engraving and Vector Engraving
IS In how the laser processes the
data.

Raster objects are composed of
. b, (3 —_— pixels, and the laser cutter reads
eeamE.  “iefmt” | | these objects like a traditional printer
e = moving side to side).

Vector objects are composed of
paths and lines, and the laser
cutter engraves along the paths and
ines.

Raster Engraving is best used for
photos and large areas.

Use com_mand+y ONn mac anpl ctrl+y on windows t_o view . Engraving is best used for
ines easier. Make sure to switch back before saving. engraving paths and simple lines.




Setup for Scoring a Line Page - 9

oo A 1=+ e oo Edit a line or object by opening the
% U8ntitled-1* @ 17.13 % (RGB/Preview) X TestFile [Converted] Al* @ 54.21 % (RGB/Preview) 3 3 4I e e P ro pe rti eS Tab |

> Path

>‘ e .

"‘ Transform ]

» TRl Sct the color of the line (Stroke) or
s &0 v wx object (Fill) to Global Pure BLUE
T, gg

----- ; R oy Set the line weight of the line or

; 3 object to .01 pts.

| , VaEE WA d 4 4 4
e PRt - -
* All objects should be inside the boundaries of the box above. Use the magenta line Th IS ||ne O I ObJeCt Wi “ be SCO R E D
for placement when cutting basswood. Use the violet lines when cutting acrylic. f
¢ All BLACK objects or lines will be SKIPPED. by th e |aser CUtter'
® Assign global RED for vector lines that will be CUT. The lineweight must be .01 pt:
® Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line- 4 ™ @ Bm o

Offset Path Recolor
weight must be .01 pts.

| | | | o P e This Is useful for scoring chipboard,
® Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be

thicker than .75 pts to be raster engraved. USE SPARINGLY! Raster engraving takes Arrange p a p e r O r C a rd b 0 a rd i n p re p a rat i O n
much longer than vector engraving. Start Global Edit , .
for folding.
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® Assign global BLUE for vector lines that will be SCORED. The lineweight must be
) .01 pts. This setting cannot be used on acrylic or basswood.
2

17.13% v Selection >




Saving the lllustrator File for Cutting Page - 10

@) #® = New... &N Adobe lllustrator 2021 Q QY Q- o @S =~ Adobe lllustrator 2021 o Q@ Q-
New from Template... 3N

X Untitled-1*¢  Qpen... 60 |rted].Al* @ 54.21 % (RGB/Preview) X Untitled-1* @ 17.13 % (RGB/Preview)  x TestFile [Converted].Al* @ 54.21 % (RGB/Preview)
5 Properties Layers Libraries Properties Layers Libraries
8 Open Recent Files >

. db U No Selection No Selection

Close BW ; N Document Save As
Close All ; :
! Units: Inches Units: Inches

- Save As: | MyLaserCutFile|ai
Rrpoare: 4 Artboard: 1 v
Tags:

Edit Arttiards : Edit Artboards
Where: | [ Desktop

Document

Save As...

ted Slices...
Version History
Save as Template...

90X ,CLET
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Ruler & Grids r @ v Ruler & Grids
Save Cloud Document Format: Adobe lllustrator (ai)

Search Adobe Stock...

Guides :H: 7H Guides
2
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Snap Options k= =] . . Snap Options k=] k=]
Export + i [ + £

Preferences . Preferences

(3P E ¥ Keyboard Increment: 0.0138i < Keyboard Increment: 0.0139 in

Scripts >
[] Use Preview Bounds [] use Preview Bounds

= | be inside the boundaries of the box above. Use the magenta lines * All objects should be inside the boundaries of the box above. Use the magenta lines
Document SetUp"' %P [] Scale Corners ‘ [] Scale Corners

Document Color Mode “Sn cutting basswood. Use the violet lines when cutting acrylic. z for placement when cutting basswood. Use the violet lines when cutting acrylic.
: . . ) [ Scale Strokes & Effects ) . . (] Scale Strokes & Effects
File Info... A48 or lines will be SKIPPED. * All BLACK objects or lines will be SRIPPED.
Print... .88 for vector lines that will be CUT. The lineweight must be .01 pts. P * Assign global RED for vector lines that will be CUT. The lineweight must be .01 pts.
® Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line- ® Assign global YELLOW for vector lines that will be VECTOR ENGRAVED. The line-
Document Setup Preferences Document Setup Preferefles
weight must be .01 pts. weight must be .01 pts.
* Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be * Assign global GREEN to lines and objects to be RASTER ENGRAVED. Lines must be

thicker than .75 pts to be raster engraved. USE SPARINGLY! Raster engraving takes : thicker than .75 pts to be raster engraved. USE SPARINGLY! Raster engraving takes

Quick Actions

much longer than vector engraving. much longer than vector engraving.
® Assign global BLUE for vector lines that will be SCORED. The lineweight must be ® Assign global BLUE for vector lines that will be SCORED. The lineweight must be
.01 pts. This setting cannot be used on acrylic or basswood. .01 pts. This setting cannot be used on acrylic or basswood.

Selection Selection

To save the file for cutting, go to File > Save As... Name the file yourname_lasercut_mmddyy.ai

This is found at the top lefthand corner of the screen. Make sure the file is saved as an Adobe lllustrator file.

Leave the lllustrator Options as defaut and click “OK”



